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Backup: Your Most Important Task 
Introduction 
Everyone who uses a computer to save or store files will at some time or another experience 
that heart stopping moment when they realize their files are lost.  

 
Don't let those files be lost forever. It's plain and simple: if you use a computer, you need to 
backup your data. It's not a question of whether you should, but rather how you should...  

Why Backup? 
Every day individuals, businesses, and organizations lose their precious files due to a drive 
failure, inadvertent deletion, or other unwanted action or event. The result is a great deal of 
stress, anxiety, and in the case of businesses, lost revenue. 

The computer hard drive that stores all your data has moving parts, and in time your hard 
drive will wear out and fail. It's just a matter of when. You need to keep a copy of all your 
important data somewhere else. 

 
Apart from hard drive failure, there are many other likely scenarios that may result in the loss 
of your valuable files like power failures and spikes, or system and file corruption due to 
viruses, worms, or other malicious attacks. 

Types of Backup 
• Single file 

This type of backup creates a single file of all the files selected for backing up.  This is 
the most common format for Backup Programs.  Typically these programs offer the 
following options: 

 Compression – allows the files to be compressed which can save space on the 
backup media – but also slows down the process 

 Encryption – allows a password to be set so that files can only be restored if the 
password is known 

In most cases, it is necessary to use the same program that created the backup to 
restore the files 

A zip file is a typical example of a single file copy or backup of multiple files and 
folders. 
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• Exact or duplicate copy 
This type of backup makes a duplicate or exact copy of all your files and folders, so 
that opening the backup folder will look exactly like opening the original folder.  Any 
file manager (e.g. Windows Explorer) can be used to restore a file from the backup. 

• Backup methods 
 Full - A backup of all (selected) files on the system.  Can take a long time if you 

have a lot of files. 
 Differential - A cumulative backup of all changes made since the last full 

backup. The advantage to this is the quicker recovery time, requiring only a full 
backup and the latest differential backup to restore the system. The 
disadvantage is that for each day elapsed since the last full backup, more data 
needs to be backed up, especially if a majority of the data has been changed. 

 Incremental - A backup that only contains the files that have changed since the 
most recent backup (either full or incremental). The advantage of this is quicker 
backup times, as only changed files need to be saved. The disadvantage is 
longer recovery times, as the latest full backup, and all incremental backups up 
to the date of data loss need to be restored. 

These methods work differently depending on the type of backup chosen.  A single file 
backup will produce a single file for each method.  For example, a Full BU on Monday 
produces a file containing all the backed up documents.  An Incremental BU on Tues, Wed, 
Thurs & Fri will each produce a single file of just the changed (for that day) documents. 

The Duplicate method maintains an exact copy of all your original documents, but only 
updates the documents that have changed. 

Synchronization 
A backup maintains a second copy of your files. A backup doesn't change the original files. If 
you accidentally delete a file, or make changes you don't want, etc. then you can restore the 
original file from the backup. 

When synchronizing however, you are copying files between two computers. Perhaps you've 
got a desktop computer and a notebook computer and have copies of the same files on both 
computers. You may be changing those files either on your desktop or notebook depending 
on the situation. With synchronization, files are copied from one to the other based on when 
they were last changed. Files may also be deleted, e.g. you delete a file on your notebook 
and so want the same file on your desktop to be deleted. 

Where to make your backups 
There are many different types of media that you may choose to backup onto, and each has 
their own advantages and disadvantages. The first thing you'll have to work out is what suits 
your particular circumstance.  

 
It's generally a good idea to choose media that allows you to backup all the data you wish to 
without having to 'span' the backup. For example, you may need many CDs to backup all 
your information. The problem with this kind of backup is that it requires your intervention to 
replace the new media as each disk is required. It also requires a “single file” type of backup.  
A backup that can automatically run without your intervention will save you a great deal of 
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time over the long run. An external USB hard drive for example, can plug straight into a 
computer and provide an instant large capacity space for your backups.  

Most people consider backing up to CDR/W or DVDR/W, however these mediums are less 
stable over longer periods of time and very unreliable. For pure convenience there's nothing 
easier than making relatively small capacity backups to a USB memory stick that you can 
easily plug in, and then transfer to another location.   

Whatever you choose make sure your chosen media is easy to use, requires as little 
intervention as possible, and can easily be scheduled. 

How Often Should You Make a Backup of Your Files? 

 

If you work on your documents each day, you need to backup at least once a 
day. If you accidentally delete a file, or a program crashes while you're 
working on a document, you need to be in a position where you can recover 
that file from your backup copy, so you may well want to run the backup 
program in the background. The more impressive backup programs can also 
copy open and locked files so that a backup can be made even when you're 
working on a document. 

For most people, backing up once a day works well.  Later, I will show how to 
implement a strategy of just leaving the computer in standby, having the 
computer “wake up” do a backup and then shut down the computer. 

Where to Keep your Backups 
You might want store a copy of all your important files in a different location to where your 
computer is situated. It's not a great deal of use having the copy of your files on your external 
hard drive which is constantly plugged into your computer. A thief won't leave your additional 
drive for you to recover your lost files, a fire or flood won't distinguish between your computer 
and your external drive. A reasonable strategy might be to make a second backup once a 
week or month to keep somewhere safe. 

What Data Should Be Backed Up? 
If you keep all your documents in “My Documents” then backing up this folder is the first 
priority.  For Windows Vista users, Photos, Music and Videos are no longer part of 
Documents and will need to be also backed up. 

If you use an email client like Outlook Express, Outlook or Windows Mail (Vista) you will also 
want to back up these files 

I also like to backup my desktop and my favorites. 

If you create a single file backup, it’s also important to backup the program used for the 
backup procedure itself. You'll also need to save the serial number for this program and 
others in a secure yet memorable location so you can restore your backup to the original 
location at a later date should you need to. 

Disk Imaging 
To make an exact copy of your hard drive, including the Windows operating system, you 
must use 'disk imaging' software. Disk imaging copies the entire disk (the parts that are used) 
bit-by-bit. This results in a copy that will take up a lot of disk space, and take much longer to 
copy. 

Disk imaging isn't generally the best answer to backing up for a number of reasons. 
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People who use disk imaging normally use file backup programs as well. For example, they 
take a snapshot of their hard disk using the disk imaging software, e. g. every, month, or at 
ad-hoc times, but use the file backup program to make regular backups of their important 
files, e. g. scheduled every day. When doing a restore they first restore the disk image then 
restore their files using the file backup program. 

Backup programs 
Some versions of Windows XP come with a backup program.  However it is not very flexible. 
Windows Vista also comes with a much better backup utility.  Will demo this later for those 
with Vista. There are many programs available both freeware and for purchase.  Most 
CD/DVD software (like Nero or Roxio) also come with backup utilities. 

As I like to backup every day, unattended and to be able to restore easily.  I use a program 
called SyncBack, that comes in both a freeware and for purchase versions.  Today, we’ll be 
using the freeware version.  I will not be showing how to back up to CD/DVD as this doesn’t 
meet my criteria.   

SyncBack is a product of 2BrightSparks who have a comprehensive website at 
www.2brightsparks.com   I’ve included the help part of their website on your CD.  Also on the 
CD is both the freeware program and the for purchase version (can try free for 15days) 

Installing the program 
1. Put CD in computer, open My Computer and double-click the CD,  
2. Double-click the “SyncBack Freeware” folder and double-click SyncBack_Setup.exe 

and just follow the instructions. 

Documentation 
• Open SyncBack.  As we have no profiles yet – asked to create – click cancel 
• Click Help and help again. Select Basic Operation and Creating a profile.  This help 

menu is very extensive. 
• Go back to the CD, double-click “Help_and_Tutorials.html”.  Review tutorials and e-

books. 
• Please use the above resources as your documentation. 

Create 1st Backup profile (profile =job or task) - Windows XP 
1. If you have an external hard drive or USB flash drive, plug it in now 
2. Open My Computer and check the drive letter for the USB drive (see appendix for 

giving a name to your USB drive).  (those that don’t have a USB drive – we will use 
another drive in the center’s computers – the F: (Image) drive. 

3. First, we'll make the folders where we will keep our Backups.  In My Computer, 
double-click the Drive that will be used for your backups. 

4. Create a new folder called 
BackUp and then create a new 
subfolder called Documents. 

5. Open SyncBack.  As we have no 
profiles yet – asked to create – 
click cancel 

6. Click Profile>New, select 
Backup (the default), and click 
OK  
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7. Name this profile Documents. 
8. In the Simple tab, leave the default 

“Backup source directories files, 
including all the sub-directories” 

9. Click the folder icon at right end of 
Source Box, and in the Browse For 
Folders window, select My Documents.  
Click OK 

10. Click the folder icon at right end of Destination Box.  Select My Computer>the 
drive letter of your Backup Drive (external USB drive - F: if you didn’t bring one), then 
select the folder  BackUp, then Documents (created in step 4 above).  Click OK 



Document Name  GCCLC 

6 Roger Thornburn Feb 2009 

11. Click OK again to complete the profile.  If you want to run a simulation, click Yes.  
Lets do that! 

12. A list of files to be copied appears – click Continue simulation 

Run the Back Up Profile 
1. In the SyncBack main window, select the Documents profile and click Run.  A list of 

all the files that will be backed up appears. 
2. Click Continue Run to complete the back up 
3. When completed, the main window indicates date and time of last run and the result. 

Change a file. 
• Open My Documents and select any Word document (has a .doc or .rtf extension) 
• Delete a line and then close Word and click Yes to Save the change 

Re-run the back up 
• Follow instructions above to run the Documents backup 
• Notice only the one changed file appears and the backup was very fast 

That’s it, we have done a backup of all files and folders in My Documents 

That's it!  To backup ALL your documents and photos, etc. all you need to do is 
open SyncBack and run the "Documents" profile (or job). 

Other options (these are optional) 
• Open SyncBack and select our Documents profile and click Modify 
• Click Advanced tab – review last section “What to do if file is in destination but 

not in the source”  Consider selecting delete from destination. Paid version allows to 
set #days before deleting. 

• Click Filter tab.  We’ll Add to Files NOT to Copy “thumbs.db” and “desktop.ini” as 
these are system files not needed.  Notice, if we only wanted to back up our photos, 
we could add in files to copy “*.jpg” and only files with the jpg extension would be 
backed up. 

• At the bottom is the Expert button.   
 Go to Auto-close tab.  This will close any open application before making the 

back up.  For instance, Outlook files cannot be backed up if Outlook is open.  If 
you’re going to run in background during normal working time – don’t add 
anything.  I run my backups late evening – So add Word, Outlook to close. 

 Go to Programs tab.  Can run a program before or after the profile runs.  If time 
will show how to run a small batch file that shuts down computer after backup 

Create other profiles 
Desktop 
Often leave stuff on desktop – so good to back up 

• As creating first profile, except name it Desktop.  For the Source (folder to backup) 
select Desktop.   

• For the Destination (where backups are kept), select backup drive>BackUp and 
create a new folder called Desktop using the New Folder Button create a folder in 
the backup drive called Desktop (see following graphic) 
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E-mail 
We could create a new profile using the full path, as we have done previously, but using the 
correct path for Outlook, Outlook Express and your Address book.  However, these files are 
hidden, so you would need to follow the instructions in the Appendix to find them – both 
using the paths given and following the Note to be able to see hidden files and folders. 

Instead we will setup one profile to gather up all this information 
1. Create a new profile named Email 
2. Select the source as C:\Documents and Settings\USER - in this class “User” is 

Student (and Roger in the graphic below) 
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3. Create a new folder in our backup drive – called Email 
4. In the Filter tab, add 

the following file 
types - *.pst, *.dbx, 
*.wab    
All Outlook data is 
stored in .pst files,  
All Outlook Express 
data is stored in .dbx 
files  
The address book is 
a .wab file.   
These will be the 
only files found and 
copied. 

See appendix at the end for 
the complete paths for 
common application settings 

 

 

 

 
 

 

Running all profiles at once 
Typically we will want to run all these profiles together.  To do this we create a Group Profile. 

1. Create a New Profile, but this time select  “Group” and name it My Normal Backup 
2. In the new window that opens, click the double arrow pointing to the right to select 

all the profiles we’ve created, into this group.  
3. Other options.  Don’t run in parallel. To set a profile hot key, click in the box and 

select your hot key (e.g. ctrl+F10) 
4. Click OK 
5. Click No for simulation 

Preferences 
• Click on preferences and select any changes – eg “Skip Differences Window” and 

“Show Groups Only” 
Now run our Group profile “My Normal Backup” to do a complete backup of all our key files 
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To restore a file(s) 
Method 1 
Open My Computer, double-click the drive you backed up to, and there are all your backed 
up folders and files.  These can be copied back to their original location – if necessary. 

Method 2 
This is the easy way using the Restore function of SyncBack.  This reverses the Source and 
Destination folders. 

• Open SyncBack and select the profile you wish to restore 
• Click the restore button and follow instructions! 

Scheduling Backups 
It's very easy to have your important files backed up without you having 
to remember to do so. The backup can be done automatically, every 
day, while you sleep. It can be done while you're on holiday or out of the 
office. Computers are designed to help automate tasks, so let your 
computer and software automate your backups. 

1. Select the profile to schedule – in this case “My Normal Backup” and click the 
Schedule button.  Select Yes in the next box 

2. In the password restriction box, click OK 
3. Important - in the Schedule Task window, make sure the Task tab is selected.  Now 

check the “Run only if logged on” check box and click Apply. 
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4. Now click the Schedule tab and select whether daily, weekly, etc, the days (if 
necessary) and the time.  
Remember, the computer must 
be on (but can be in 
standby/sleep mode) and the 
backup drive connected at this 
time. 

 

 

 

 

 

5. In the Settings tab, make sure 
the “Wake Computer check 
mark has been checked. (To 
test, go back to Schedule and 
set the time to 2 minutes from now 
– click OK twice and Exit on 
SyncBack.  When time has past, 
open SyncBack and look at result) 

A possible strategy 
This is how I set up my backups.  I put my 
computer into standby (extremely low 
power use) when I’ve finished using the 
computer for the day.  I have my backups 
scheduled to start at 10:30pm (as I rarely 
use the computer at this time) – and as I 
set the scheduled tasks to bring the 
computer out of standby – the computer 
wakes up and completes the backups.  
When they’ve finished, I have the last 
Profile shutdown the computer completely. 

To do this: 

• Copy the file “shutdown.bat” from 
the Shutdown folder on the CD to 
your C: Drive 

• Open SyncBack.  Select the last profile and click Modify 
• Click the Expert button 
• Click the Programs tab and click the folder icon at the right of the “Run after 

Profile” box 
• In the “Look in” drop down, select C: drive, then scroll down and select 

Shutdown.bat and click OK  
We will leave testing this as the last thing we do – as it closes the computer and because of 
our special program DeepFreeze, SynvBack will be removed! 
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Using Windows Vista 
Vista's built in program 
Vista comes with it's own Backup program.  Backups can only be made to CD/DVD or 
another hard drive. - it will not backup to a  Flash Drive.  All the backed up files and folders 
are saved as a single "Zip" file and backup strategy is incremental.  A Full Backup has to be 
made manually, when required.  Hence, when a restore is performed, it's necessary to know 
which of the backups is your last Full backup, so this can be restored, and then all 
subsequent incremental backups must also be restored. 

However, it is extremely easy to set up and use. 

1. Make sure your external hard drive is plugged in to your computer 
2. Open Control Panel and double-click Backup and Restore Center 
3. Click Back up files and in the next window, make sure your external hard drive is 

selected for where you want to save your backups.  Click Next 
4. In this window, select the type of files to back up.  Leaving all checked is normal.  

Click Next 
5. Now you can select a schedule.  At the time chosen to do the back up, the computer 

will need to be on and the external drive connected. 
Now a Full back up will be performed and incremental backups made at the scheduled times 

To force a Full back up again, follow steps 1 & 2.  Then click Change settings and then click 
Change back up settings and keep clicking Next. 
Using Syncback 
The procedure for using Syncback in Vista is exactly the same as described for Windows XP.  
The only difference comes when selecting the folders to backup.  So follow all instructions 
given for Windows XP, except step 9 on P5, and replace with: 

• Click the folder icon at right end of Source Box, and in the Browse For Folders 
window, select Your UserName, then Documents.  Click OK 
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Appendix 
Assign a name to a USB drive. 

• Open My Computer 
• Connect USB drive (either a USB flash drive or external USB hard drive) 
• Watch the My Computer window and the USB drive just connected will appear (may 

need to wait a few moments).  Right click this drive and select “rename” 
• Rename the drive to what you want –  for example, “BU Drive” and press the Enter 

key 
• Now, this USB Drive can always be identified in My Computer or in SyncBack, by 

looking for the name you gave it in the previous step. 

Finding Your Files 
Here are some directions of a few places you can check for the location of your important 
files are stored. Note that systems may have been set up differently and you may need to 
take a little time to find the location of particular files on your computer. If you experience 
difficulties use the Windows search tool available by going to Start > Search. 

For the average user there are two main locations from which you will probably backup files: 
My Documents which will most likely contain your day to day files like Word files etc., and 
Your User Profile which stores application specific settings and files. 

The Path to Your User Profile 
C:\Documents and Settings\USER 
USER is the name you logged in as.  This can be found by clicking Start and the User will be 
displayed at the top of the box.  Typical Users are Your Name, Authorized User, Owner. 

Note: To see some of these folders, it is necessary to be able to view hidden files and 
folders.  To change this setting, open My Documents and on the toolbar, click Tools>Folder 
Options, then click the View tab and click the radio button for “Show hidden files and 
folders” 

Common paths 
Desktop: C:\Documents and Settings\USER\desktop  
Favorites: C:\Documents and Settings\USER\Favorites 

Outlook Express: C:\Documents and Settings\USER\Local Settings\Application 
Data\Identities 

Outlook: C:\Documents and Settings\USER\Local Settings\Application 
Data\Microsoft\Outlook 

Address book: C:\Documents and Settings\ USER \Application Data\Microsoft\Address 
Book 

Templates and Stationary: C:\Documents and Settings\USER\Application Data\Microsoft 

Further info 
• Outlook Personal Folders Files (.pst)  The Personal Folder file (.pst / PST) is the 

place where Outlook stores its data (when you're using Outlook without Microsoft® 
Exchange Server).  
 
Each Personal Folder file contains all of your Outlook folders, including the In box, 
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Calendar, and Contacts. You may have a single .pst file (usually called Internet 
Folders or Personal Folders in your Folder List), and you may also have an 
additional .pst file that you use to archive messages (named Archive Folders). By 
backing up these PST files you will be backing up all your Outlook information. 
 
You can find the location of the main PST file by right-clicking on the Outlook Today 
icon found in your Outlook shortcuts, or the Outlook Today icon found in your folder 
list and then left-clicking Properties. Once the Properties dialog box is displayed, 
click the Advanced button. 
 
The Path... shown indicates where your Personal Folder file can be found. An 
example path follows: 
 
C:\Documents and Settings\USER\Local Settings\Application 
Data\Microsoft\Outlook\Outlook.pst 

• Outlook Express    Go to the Outlook Express menu and select Tools > Options > 
Maintenance then click the Store Folder button. You'll see a dialog with the name of 
the directory that has your mail files. If you look in that directory you'll find files named 
after your mail folders and news groups. They all have a .DBX suffix. All your Outlook 
Express messages are kept in these database files. If you make copies of these files 
regularly, you'll have a safe backup of your OE mail. 

• Mozilla Firefox All bookmarks are stored in a file called bookmarks.html and is stored 
in the profile folder, a typical example being: Documents and Settings\All 
Users\[Log-in Name]\Application Data\Mozilla\Profiles\  
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Notes 


